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Introduction
CHAPTER 1
Introduction

This chapter introduces the Graphical Programming Interface of EC-gfxPro-
gram, summarizes its features, and provides an overview of the user guide.

Topics

About this User Guide
Ec-gfxProgram 3



About this User Guide

Purpose of this 
user guide 

This user guide is intended to provide information and instruct a user to install 
and configure EC-gfxProgram in the context of these controllers being man-
aged by an LNS-based network management tool or EC-Net platform-based 
software. This guide is not designed to instruct the user on how to use the net-
work management tool software or programmable controller itself and there-
fore it is assumed that the user already has prior knowledge of said software 
and controllers. 

Intended 
audience

This user guide is intended for system designers, integrators, and field techni-
cians who have experience with control systems. It is recommended that any-
one installing and configuring the devices specified in this user guide have 
prior training in the usage of these devices.
4 Ec-gfxProgram



Getting Started on EC-Net for ECP & ECL Series Controllers
CHAPTER 2
Getting Started on EC-Net for ECP & 
ECL Series Controllers

This chapter provides a detailed explanation of how to configure an EC-BOS 
as a building controller with EC-Net installed on your PC. This includes install-
ing the EC-gfxProgram, adding a device to a network database, and launch-
ing EC-gfxProgram.

Topics

Pre-Configuration and Configuration Overview
Installing EC-gfxProgram
Installing the Distech Controls Distribution Files on the EC-BOS
Installing a LONWORKS Network
Configuring the LONWORKS BcpLonNetwork
Adding the WizardService to the Station
Configuring the WizardService
Organizing devices in Device Folders
Adding a Device to the Network Database
Commissioning the device
EC-Net Device Upload and Download
Discovering an Existing Network
Matching Devices
Launching EC-gfxProgram
Launching EC-gfxProgram from a Px Page using a LaunchButton Widget

NOTE: For detailed information on connecting to the internal points of a con-
troller, refer to EC-Net Platform Support Package Features for ECP & 
ECL Series Controllers in the EC-gfxProgram User Guide.
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Pre-Configuration and Configuration Overview

EC-gfxProgram requires that the EC-BOS, EC-Net Pro, and EC-Net be 
licensed for version 3.5 or higher.

Pre-
configuration 
steps 

Before installing EC-gfxProgram, adding a device to a network database, and 
launching EC-gfxProgram, the following steps must first be carried out to 
allow EC-Net to support the controllers:

1. Install EC-Net Pro on your computer.

2. Install the latest version of the Distech Controls EC-Net Support Package 
on your computer. The EC-Net Support Package installs many jar files 
required in EC-Net such as distechControls.jar, which contains the 
required services and Distech Controls devices. The latest Support Pack-
age can be installed by using the Distech Controls SmartInstaller soft-
ware, which can be downloaded from the Distech Controls website at 
www.distech-controls.com.

If you are running EC-Net 4 and your Niagara license file has a brandID 
other than distech or distechEU, you will require a license to enable the 
WizardService, RestService, and RadiusService. See Licensing the EC-
Net Support Package for a Non-Distech Controls Brand Station.

3. Connect to an EC-BOS or EC-Net Pro station. If the IP address is 
unknown for an EC-BOS, use the System Shell procedure in Recovery 
Tips in the EC-BOS Install and Startup Guide, which can be downloaded 
from the Distech Controls website at www.distechcontrols.com.

Configuration 
steps

The following steps are detailed in procedures on the following pages.

1. Install EC-gfxProgram.

2. Install the Distech Controls EC-BOS distribution file through the platform 
Distribution File Installer.

3. Connect to the station.

4. Install and configure the LONWORKS Network

5. Add the WizardService to the Station.

6. Configure the WizardService.

7. Add a device to the network database.

8. Commission the device.

9. Discover an existing network where one already exists (if necessary).

10. Match devices where the LONWORKS Network database is already estab-
lished in EC-Net (if necessary).

11. Launch device wizards to run EC-gfxProgram.

NOTE: When first logging in to the platform, the default platform username is 
distech and the default password is controls.
6 EC-gfxProgram
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Getting Started on EC-Net for ECP & ECL Series Controllers
Installing EC-gfxProgram

To program a controller, the EC-gfxProgram application must be installed. 
This application has its own setup file and requires its own installation. To 
install the EC-gfxProgram application:

1. Close any programs that are running on the PC.

2. Go to the Software Center, which can be downloaded from the Distech 
Controls website at www.distech-controls.com.

3. In the EC-gfxProgram tab, select Distech Controls EC-gfxProgram.

4. Run the Setup file and follow the installation instructions.
EC-gfxProgram 7
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Installing the Distech Controls Distribution Files on 
the EC-BOS

Install the Distech Controls distribution file onto the EC-BOS to ensure all of 
therequired modules and files are correctly installed.

1. Expand the platform tree in the Nav side bar and double-click Distribu-
tion File Installer. This will open the Distribution File Installer in the View 
Pane.

2. Click on Choose Directory at the bottom of the page and navigate to the 
location of the Support Package. These files are usually found in the
 /Niagara/EC-NET[Version#]/Distech Controls Files/ directory on the 
C:drive. Click OK.
8 EC-gfxProgram



Getting Started on EC-Net for ECP & ECL Series Controllers
3. Install the DistechControls_EC-BOS distribution file through the platform 
Distribution File Installer. Select the distribution file and click Install.

4. EC-Net will then inform you that any running station(s) must be closed in 
order to continue. Click Finish.

5. If any application needs to be stopped, allow the platform to stop them.

6. The Installing Distribution window will appear to display the progress of 
the distribution files installation. Click Close when done and allow some 
time for the EC-BOS to reboot.
EC-gfxProgram 9
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Getting Started on EC-Net for ECP & ECL Series Controllers
Installing a LONWORKS Network

In the following procedure, you add a Bcp Lon Network driver to the station 
to allow EC-gfxProgram to connect to your devices.

1. Connect to the station on the EC-Net platform. Right-click the station and 
select Connect.

NOTE: If this is the first time that the station is accessed, by default, the sta-
tion will not be displayed. Click File→Open→Open Station (or press 
Ctrl+Shift+O from your keyboard) to open the Open Station window. 
Proceed to step 2.

2. Enter the required Username and Password to access the station.
EC-gfxProgram 11



3. Install the Bcp Lon Network: Double-click Drivers under Station > Con-
fig in the Nav tree for your station and click New.

4. From the Type to Add drop-down list, select Bcp Lon Network.

5. Add one (1) Bcp Lon Network in Number to Add. Click OK.

6. Accept the default settings: Click OK. The Local Lon Device driver is 
automatically created under the Bcp Lon Network in the Nav tree.
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Getting Started on EC-Net for ECP & ECL Series Controllers
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Configuring the LONWORKS BcpLonNetwork

Before adding devices to the LONWORKS Network it must be configured cor-
rectly. Set both the WizardService Comm Config properties (see Setting the 
WizardService Comm Config Properties) and the BcpLonNetwork properties 
as follows.

Setting the BcpLonNetwrok Properties

You can access the BcpLonNetwork driver’s property sheet:

• From the Nav side bar, right-click BcpLonNetwork, select Views and 
then Property Sheet.

• From the Nav side bar, select BcpLonNetwork, click the View Selector 
and select Property Sheet.

1. Make sure that the Enabled field is checked off as true.
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Getting Started on EC-Net for ECP & ECL Series Controllers
2. Expand the Lon Comm Config field. Ensure the Repeat Timer drop-
down is set to Milli Sec96. Ensure the Receive Timer dropdown is set to 
Milli Sec384. Ensure the Transmit Timer dropdown is set to Milli 
Sec512. Ensure the Retry Count field is set to 3.

NOTE: These settings will be automatically overwritten when the Auto Update 
option in the WizardService is set to True. See Configuring the Wiz-
ardService and see Setting the WizardService Comm Config Proper-
ties.

3. Expand the Lon Netmgmt field. Set the Domain Id field to a length of 1 
and the ID to 01.

NOTE: If the configuration of the LONWORKS Network has already been 
made, then the Domain Id may be set to another number. Verify that 
the Domain Ids of the network and devices match. However, it is rec-
ommended that the Domain Id be set to a length of 1 and an ID of 01 
whenever possible.

4. Click Save in the Property Sheet menu to accept the changes.
EC-gfxProgram 15



Adding the WizardService to the Station

The WizardService allows EC-gfxProgram to connect to the EC-BOS. This 
step is optional: If the WizardService has not been installed as shown below, 
it will automatically be installed when you add a device to the station. How-
ever you will still need to configure the WizardService service as shown in 
Configuring the WizardService.

Optionally you can manually install the WizardService on the station as fol-
lows.

1. Click the Open Palette button in the Palette side bar to open the Open 
Palette selection window.

If the Palette side bar is not open in the Side Bar Pane, click Windows→Side 
Bars→ Palette to add the Palette side bar.

2. Select distechControls from the Open Palette selection window and 
click OK. This will add the distechControls palette to your Palette side 
bar.

3. Install the WizardService: Drag and drop the WizardService from the 
distechControls Palette into the Station’s Services tree.
16 EC-gfxProgram



Getting Started on EC-Net for ECP & ECL Series Controllers
NOTE: The Services tree is found within the Config tree of the station.

4. Click OK to add the WizardService on the station.
EC-gfxProgram 17



Configuring the WizardService

If the WizardService has not been installed, it will automatically be installed 
when you add a device to the station. However you will still need to configure 
the WizardService service as shown below.

The WizardService must be configured by defining parameters such as the 
communication port and/or the number of simultaneous connections. The 
WizardService property sheet can be accessed:

• From the Nav side bar, double-click WizardService in the Services tree 
of the station.

• From the Nav side bar, right-click WizardService, select Views and then 
Property Sheet.
18 EC-gfxProgram



Getting Started on EC-Net for ECP & ECL Series Controllers
Parameter Description

Status (read only) This field displays the status of the BCP Server. If the server is enabled 
(the Enabled field set to True), an {ok} status will be displayed. If the 
server is disabled (the Enabled field set to False), an {disabled} status 
will be displayed.

Fault Cause (read only) If there is a problem with the WizardService, this field will list the 
possible cause of the problem.

Enabled This field enables or disables the WizardService. Enable the server by 
setting this field to True. Likewise, the server can be disabled by setting 
this field to False.

Licensed This is true when the WizardService is licenced on this station and is 
available. When using Distech Controls controllers with a Distech 
Controls EC-Net station, these services are available by default. 

If you are running EC-Net 4 and your Niagara license file has a brandID 
other than distech or distechEU, you will require a license to enable the 
WizardService, RestService, and RadiusService. See Licensing the EC-
Net Support Package for a Non-Distech Controls Brand Station.

Port Enter the port that the station is using to communicate with EC-Net here. 
The default port is 1931. 

If application specific or line by line LONWORKS devices are being 
accessed, the LonLegacy Tcp/IP port must also be configured.

Max Connections This is the maximum number of connections (wizards) that can be 
simultaneously running. The default is 5.

Version (read only) This field displays the current version of the Wizard Service 
communication protocol.

Min Version (read only) The minimum required version of the Wizard Service communication 
protocol that is required for this service to operate.

Number Connections 
(read only)

Number of clients (wizards) currently running and using the 
WizardService. See Server Connections.

Server Connections

 - Keep Alive Delay

 - Load Manager

 - Connection

Sets the server connection parameters. See Server Connections. The 
number of supported connections is set in Max Connections.

Supported Field Bus List the network types supported by the WizardService.

Bacnet Settings Not applicable to LONWORKS controllers.

Lonworks Settings

 - TagUpdate Latency

Time during which device message tags are buffered before being sent 
to EC-gfxProgram. The default is 500 msec.
EC-gfxProgram 19



Lonworks Settings

 - Comm Config

See Setting the WizardService Comm Config Properties.

For supported controllers, the following settings are strongly 
recommended: Ensure the Repeat Timer dropdown is set to Milli 
Sec96. Ensure the Receive Timer dropdown is set to Milli Sec384. 
Ensure the Transmit Timer dropdown is set to Milli Sec512. Ensure the 
Retry Count field is set to 3. 

Sometimes, certain LONWORKS devices may process LONWORKS 
messages "slower than normal,” resulting in errors when you do 
commissioning or binding operations – where the commission or bind 
reports as failed. You can confirm such problems by using the Lon 
Utilities Manager (afterwards) and running a verify report. The verify 
report will list the inconsistencies between the bindings on the devices, 
and the list of bindings that EC-Net's LON network management 
determines that they should have. 

Under these conditions, it may be necessary to raise the Transmit Timer 
setting upwards to Milli Sec1024.

Lonworks Settings

 - Comm Config, Auto 
Update

If set to true, this pushes the Comm Config settings above to the Lon 
Comm Config on all LONWORKS BcpLonNetworks (see Configuring the 
LONWORKS BcpLonNetwork) when: 

• The EC-BOS is rebooted 

• A wizard connection is made (see Launching EC-gfxProgram on 
page 53) 

• The settings on this page are saved. 

If set to false, the settings of the individual LONWORKS 
BcpLonNetworks are preserved.

Lonworks Settings - 
Auto Build Nvs

If set to true, this auto-builds NVs when a device is added to the station. 
If set to false, this adds only the minimum NVs required to run 
EC-gfxProgram. 

You can automatically create the NVs and CPs if necessary by using the 
Build function. To minimize EC-Net memory usage, it is important to 
remove unused points by using the Trim function. See Linking, Building 
and Trimming LonWorks Component objects in EC-Net in the EC-
gfxProgram User Guide for how to use the Build and Trim functions.

Lonworks Settings 

- Auto Refresh Device 
Specific

If set to true, this enables values to be automatically read from the 
device when an nci proxy enters a subscribed state. This refreshes 
values in EC-Net, when the value is modified in the controller, for 
example, by a ComSensor.

Lonworks Settings 

- Device Specific Poll 
Frequency

This sets the LONWORKS network’s tuning policies which affects the 
status of the driver’s proxy points. Choose a poll frequency group to use 
for evaluating both write requests (e.g., to writable proxy points) as well 
as the acceptable “freshness” of read requests from polling (Slow, 
Normal, Fast). 

Parameter Description
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Getting Started on EC-Net for ECP & ECL Series Controllers
Lonworks Settings 

- Wire Sheet Layout 
Settings

This controls LONMARK object layout on the property sheet for specific 
device types.

Lonworks Settings 

- Postpone Offline Nv 
Change Types

If set to true, this postpones change type requests made by EC-
gfxProgram while the device is offline. The change type is done when the 
device returns online and is in a commissioned state.

Lonworks Settings 

- Disable Client Add 
Msg Tags

If set to true, message tags are not used. 

If set to false, nodes can declare bi-directional message tags that can be 
used to both send and receive messages. If message tags bindings are 
used, the Lon Link Manager displays their status in a fashion similar to 
that used to display network variable bindings.

Lonworks Settings 

- Si Data Save

If set to true, this maintains compatibility for controllers operating with 
LNS versions less than or equal to 3.0.

If set to false, this accelerates nv change types.

Lonworks Settings 

- Force Binding Link 
Type

If set to true, a binding must use a binding link type.

If set to false, a binding does not have to use a binding link type.

Lonworks Settings 

- Binding Link Type

Link type to use: Unknown, Standard, Reliable, Critical, Authenticated, or 
Poll Only.

Lonworks Settings 

- Ftp Retries

Number of LonWorks FTP protocol retries. 

Lonworks Settings 

- Ftp Segment Size

Number of bytes per LonWorks FTP protocol packet.

Lonworks Settings 

- Mode Set Non Critical 
Nvs

Network Variables category to exclude from the Data Recovery Service 
management.

Wizard Settings 

- Default Numeric Point 
Precision

Numeric precision for floating point numbers displayed by the proxy 
points created with the Create Points device action.

Wizard Settings 

- Create Proxy Point 
Description

Uses the EC-gfxProgram block property description to be created as a 
description property under proxy points created with the Create Points 
device action. This description can ultimately be used to provide 
descriptive information on a Px Graphic Page.

Installed Version The currently installed WizardService version. This version number 
corresponds to the currently installed support package version.

Parameter Description
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WizardService 
LonLegacy

If there is a LONWORKS service that was installed prior to version 3.2 on the 
Station, it will automatically be migrated under the WizardService_LonLegacy 
part of the property sheet where the previous configuration parameters are 
preserved. 

License Manager 

- Wizard Service 
Licensed 

- Radius Service 
Licensed 

- Rest Service Licensed

Shows the license status for the Distech Controls Support Package 
services (WizardService, RestService, and RadiusService) on the 
current station. This is true when the service is licenced on this station 
and is available. When using Distech Controls controllers with a Distech 
Controls EC-Net station, these services are available by default. 

If you are running EC-Net 4 and your Niagara license file has a brandID 
other than distech or distechEU, you will require a license to enable the 
WizardService, RestService, and RadiusService. See Licensing the EC-
Net Support Package for a Non-Distech Controls Brand Station.

WizardService_LonLeg
acy

A Wizard service extension to manage the application-specific and line 
by line programmable LONWORKS controllers. See WizardService 
LonLegacy.

RestService Not applicable to LONWORKS controllers.

RadiusService Not applicable to LONWORKS controllers.

Refresh Click to reset the fields to the last saved values of the WizardService.

Save Click to save any changes made to the fields of the WizardService.

Parameter Description

Parameter Description 

Status (read only) This field displays the status of the BCP Server. If the server is enabled 
(the Enabled field set to True), an {ok} status will be displayed. If the 
server is disabled (the Enabled field set to False), an {disabled} status 
will be displayed.
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Server Connections

The server connection parameters can be viewed as shown below.

Fault Cause (read only) If there is a problem with the WizardService, this field will list the 
possible cause of the problem.

Enabled This field enables or disables the WizardService_LonLeagacy. Enable 
the server by setting this field to True. Likewise, the server can be 
disabled by setting this field to False.

Port Set the port that the station is use to communicate with EC-Net. The 
default port is 1930.

Max Clients This is the maximum number of clients (wizards) that can be 
simultaneously running. The default is 5.

Temp Transmit Timer Sometimes, certain LONWORKS devices may process LONWORKS 
messages "slower than normal,” resulting in errors when you do 
commissioning or binding operations – where the commission or bind 
reports as failed. You can confirm such problems by using the Lon 
Utilities Manager (afterwards) and running a verify report. The verify 
report will list the inconsistencies between the bindings on the devices, 
and the list of bindings that EC-Net's LON network management 
determines that they should have. 

Under these conditions, it may be necessary to raise the transmit timer 
setting upwards to Milli Sec1024.

Client Path This is the client path where the application to launch the EC-Net 
Wizards is found. It is recommended that this field not be modified.

Version (read only) This field displays the current version of the legacy Wizard Service 
communication protocol.

Number Connections 
(read only)

Number of clients (wizards) currently running and using the 
WizardService.

Wizard Settings Stubs container that allows the reuse of EC-Net categories for managing 
access rights to these applications.

Units This field determines the default unit of measurement when a wizard is 
launched.

Parameter Description 
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Parameter Description 

Server Connections 

- Keep Alive Delay

Set the delay after which an idle connection is disconnected. This is 
calculated from the Last Transaction Time shown below in the 
connection.

Server Connections 

- Load Manager

The load manager disrupts BACnet and LONWORKS EC-gfxProgram 
debugging sessions for heavily loaded stations in order to avoid 
watchdog resets. 

Enable: Enable the load manager. 

Detected Overload becomes true when the platform CPU (%) 
remains above the Full load Threashold for a duration at least equal 
to the Full load delay. 

EC-gfxProgram debugging will be disrupted when the Detected 
Overload flag becomes true. 

The flag is reset with the reset action available on the Load Manager: 
right-click Load Manager and select Reset.
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Setting the WizardService Comm Config Properties

If Auto Update is set to True, the current Comm Config properties from the 
WizardService define the master LONWORKS network settings that will over-
write the Lon Comm Config settings of all BcpLonNetwork property sheets 
when: 

• The EC-BOS is rebooted

• A wizard connection is made (see Launching EC-gfxProgram) 

• The settings on this page are saved

• By right-clicking Comm Config and selecting Actions > Update Net-
works.

For a LONWORKS network to best be able to handle the traffic while configur-
ing and debugging Distech Controls controllers, it is important to use the fol-
lowing settings: Ensure the Repeat Timer dropdown is set to Milli Sec96. 
Ensure the Receive Timer dropdown is set to Milli Sec384. Ensure the 
Transmit Timer dropdown is set to Milli Sec512. Ensure the Retry Count 
field is set to 3. The Comm Config settings can be applied to all BcpLonNet-
work property sheets by right-clicking Comm Config and selecting Actions > 
Set To Default.

Sometimes, certain LONWORKS devices may process LONWORKS messages 
"slower than normal,” resulting in errors when you do commissioning or bind-
ing operations – where the commission or bind reports as failed. You can con-
firm such problems by using the Lon Utilities Manager (afterwards) and 
running a verify report. The verify report will list the inconsistencies between 
the bindings on the devices, and the list of bindings that EC-Net's LON net-
work management determines that they should have.

Under these conditions, it may be necessary to raise the transmit timer setting 
(shown as Temp Transmit Timer) upwards to Milli Sec1024.

Server Connections 

- Connection1 

- Connection2

 …

Inet Address: The Station name or IP address of the PC or Client 
Application making this connection. 

User Name: The user name from the Workbench or EC-gfxProgram 
used to connect to the EC-Net. 

Application Name: The name of the connected application. 

Authentication Type: How the application connected. Workbench or 
Digest (launch from desktop). 

Protocol Version: The bcp protocol version. 

Login Time: The time the connection was established. 

Last Transaction Time: The time of the last transaction.

Parameter Description 
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If the EC-BOS operates with one or more LONWORKS networks that have 
other requirements for the Comm Config setting, then it is very important to 
set Auto Update to False. This prevents the Lon Comm Config settings of 
all BcpLonNetwork property sheets from being overwritten when the EC-
BOS reboots or when EC-gfxProgram is started.

You can access the Comm Config property sheet:

• From the Nav side bar, right-click Comm Config, select Views > Prop-
erty Sheet.

• From the Nav side bar, select Comm Config, click the View Selector and 
select Property Sheet.

1. If all LONWORKS networks can use the same communication settings 
shown above, set Auto Update to True. 

Otherwise set Auto Update to False and click Save. Skip to Setting the 
BcpLonNetwrok Properties.

2. Right-click Comm Config and select Actions > Set To Default. This sets 
the appropriate values necessary for use with Distech Controls control-
lers.

3. Click Save to accept the changes.
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Parameter Description 

Set To Default This sets the default values recommended by Distech Controls for Repeat 
Timer, Receive Timer, Transmit Timer, and Retry Count.

Update Networks This pushes the current Comm Config properties from the WizardService 
to overwrite the Lon Comm Config settings of all BcpLonNetwork 
property sheets.
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Organizing devices in Device Folders

Use a device folder to group similar devices together (for example, by floor). 
Create these folders first and then add the controllers directly into the appro-
priate folder.

1. Double-click the BcpLonNetwork driver in the Nav Side Bar. This will dis-
play the LONWORKS Network database in the View Pane. Click New 
Folder. 

2. Name the new folder and click OK.

3. Double-click the folder to go into it. 

4. When adding a controller, add it directly into the folder.
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Adding a Device to the Network Database

NOTE: In order to add, configure, and/or monitor LONWORKS devices, there 
must be a LONWORKS Network already established in the station. See 
Installing a LONWORKS Network and Configuring the LONWORKS 
BcpLonNetwork.

Once the LONWORKS Network has been configured, devices can be added to 
the LONWORKS Network that is running from the EC-BOS station. 

If the WizardService has not been installed, it will automatically be installed 
when you add a device to the station. However you will still need to configure 
the WizardService service. See Configuring the WizardService.

To add devices to the LONWORKS Network:

1. From the distechControls palette, install the device driver: Expand the 
Drivers folder and drag and drop the BcpLonworksDevice driver from 
the distechControls palette onto the BcpLonNetwork tree.

2. Give the device a descriptive name. Click OK to add the device driver on 
the station.
EC-gfxProgram 29



The driver will appear below BcpLonNetwork in both the Nav Side Bar 
and the View Pane. In the View Pane the device will be highlighted in yel-
low. This means that the device has yet to be commissioned. 

3. Right-click the device and select [Device Model] and set the controller’s 
model.

4. In the Model Selector popup, select the controller’s model type from the 
list and click OK.

5. Wait for a Build Success message from EC-Net. When the controller’s 
points are built, the Commission button becomes available in the 
BcpLonNetwork commissioning screen. See Commissioning the device.
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Commissioning the device

Once a device has been added to the LONWORKS Network it must be commis-
sioned. The device can be commissioned using two methods; via the device’s 
service pin or by manually entering the device’s Neuron ID number.

Commissioning the Device via the Service Pin

1. Double-click BcpLonNetwork under the Station then select the device 
(highlighted in yellow) and click Commission. The Commission window 
will appear.

2. Click Service Pin and then press the Service pin button on the device.

Wait for the Lon Commission progress bar to complete. The device is 
now ready to be configured. Notice that the state of the device changed 
from Unknown to Config Online.

3. Wait for a Lon Commission Success message from EC-Net.

4. In the device’s property sheet, the Commissioned property is true. This 
means the device is properly commissioned (domain, subnet, and node in 
the database are the same as those in the device).

5. Upload the transient (nvs) and persistent (ncis and cps) data from the 
device. See Device Upload.

Commissioning the Device Manually

To commission a device with its Neuron ID, the device must be online. When 
the network is offline, you can assign Neuron IDs to devices. When the net-
work becomes online, continue with step 3. 

1. Right-click the BcpLonworksDevice either in the Nav Side Bar or in the 
View Pane, select Views > AX Property Sheet. This will open the 
device’s property sheet in the View Pane.
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2. Expand the Device Data tree and enter the device’s Neuron ID number in 
the Neuron ID field. Click Save when finished.

3. Once the network is available, go to the LONWORKS Network database 
(by double-clicking on the BcpLonNetwork entry in the Nav Side Bar). 
Select the device and click Commission. 

4. In the Commission window, the device’s Neuron ID number is shown in 
the Neuron ID field. Click Apply.
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The device is now ready to be configured. Notice that the state of the 
device changed from Unknown to Config Online.

5. Wait for a Lon Commission Success message from EC-Net.

6. In the device’s property sheet, the Commissioned property is true. This 
means the device is properly commissioned (domain, subnet, and node in 
the database are the same as those in the device).

7. Upload the transient (nvs) and persistent (ncis and cps) data from the 
device. See Device Upload.
EC-gfxProgram 33



EC-Net Device Upload and Download

Device Upload

Upload reads transient (nvs) and persistent (ncis and cps) data from the 
device and writes to the station’s database (Lon device). This is necessary 
when adding a new device to the EC-Net database. Proceed as follows.

1. Right-click the device and select Actions > Upload.

2. An Upload dialog box allows you to select the type of data. Typically, you 
leave dialog parameters at their default settings (true)—recursive is 
always recommended. Click OK.

NOTE: An Upload action is also available at the BcpLonNetwork level—with 
the same Upload dialog selections as shown in the figure above. This 
provides a “global upload” from all Lon devices.

Device Download

Download writes persistent data (ncis and cps) to the device from values in 
the station’s database (Lon device). This is necessary when you add or mod-
ify blocks in your code that are available as network variables while the con-
troller is offline. Proceed as follows.

1. Right-click the device and select Actions > Download.
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2. A Download dialog box allows you to select recursive writes. Typically, 
you leave recursive at default (true), to write to all child data items. Use 
Download to restore nci and cp values to “known good” values, as previ-
ously saved in the station. Click OK.

NOTE: A Download action is also available at the BcpLonNetwork level—
with the same Download dialog selections as shown in the figure 
above. This provides a “global download” from all Lon devices.
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Discovering an Existing Network

There are instances where a LONWORKS Network will be created in EC-Net at 
a site that already has one created. This requires that the existing network be 
“discovered” and then added to the LONWORKS Network being created in EC-
Net.

1. Double-click the BcpLonNetwork driver in the Nav Side Bar. This will dis-
play the LONWORKS Network database in the View Pane. Click Discover. 
The View Pane will become divided into two sections; one listing the LON-
WORKS Network database and the other listing all discovered devices.

2. If the controllers are discovered, skip to step 12. If the controllers are not 
discovered, the controllers may have been previously commissioned with 
another Domain Id. For example, ECC-VAVs and EC-Displays are fac-
tory commissioned with a Domain Id Length = 6 and Id = fb 58 b2 40 f1 
3f. The solution is to:

a. Change the Domain Id of the BcpLonNetwork to that of the control-
ler.

b. Add the controller to the database.

c. If necessary, change the Domain Id of the BcpLonNetwork back to 
the original number (EC-Net updates the Domain Id of all devices in 
the database).

d. Commission the device to update the Domain Id of all devices in the 
database.

3. Press the Service Pin on the device. The device appears in the Discov-
ered devices list. Note the device Name.

4. Right-click the BcpLonNetwork in the Nav Side Bar, select Views and 
then Lon Utilities Manager. 
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5. In the Device drop-down list, select the device that was found with the 
Service Pin. Set Command to Data Structs and SubCommand to 
Domain Table. Click Execute.

6. If the domain length and domain ID are the same as the BcpLonNetwork 
properties, skip forward to step 11.

7. Note the Domain Length and Domain ID for this device.

8. Right-click the BcpLonNetwork in the Nav Side Bar, select Views and 
then AX Property Sheet. 

9. Set the Domain Length and Domain ID to that of the Device.
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10. Click Save.

11. Double-click the BcpLonNetwork driver in the Nav Side Bar. This will dis-
play the LONWORKS Network database in the View Pane. Click Discover. 
The View Pane will become divided into two sections; one listing the LON-
WORKS Network database and the other listing all discovered devices.

12. To add the discovered devices, select them, and click Add. The Add win-
dow will appear. Click OK.

13. The discovered devices have been added to the LONWORKS Network 
database.

Multiple controllers can be added to the network at the same time. 
Hold the Ctrl key and select all the devices to be added to the 
network then click Add.
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14. If necessary, set the Domain Length and Domain ID to the one you want 
all network devices to operate on. Right-click the BcpLonNetwork in the 
Nav Side Bar, select Views and then AX Property Sheet. 

NOTE: It is recommended that the Domain Id be set to a length of 1 and an id 
of 01 whenever possible.

15. Click Save.

16. Commission the devices. See Commissioning the device.
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Matching Devices

There are instances when a site has an existing LONWORKS Network and 
there is a LONWORKS Network database already established in EC-Net for 
that site. In this instance it would be necessary to match the devices from the 
site to the devices in the LONWORKS Network database. To match devices:

1. Double-click the BcpLonNetwork driver in the Nav Side Bar. This will dis-
play the LONWORKS Network database in the View Pane. Click Discover. 
The View Pane will become divided into two sections; one listing the LON-
WORKS Network database and the other listing all discovered devices.

2. Select the device from the Discovered section and the device it is to be 
matched to from the Database section and click Match.

3. The Match window will appear. Click OK to match the devices.

The devices are now matched and added to the LONWORKS Network data-
base.
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Launching EC-gfxProgram

EC-gfxProgram allows the user to program and/or configure an EC-gfxPro-
gram compatible device through the EC-Net platform.

NOTE: The EC-gfxProgram application must be installed on the PC running 
EC-Net before it can be launched. 

Use any of the following methods to open EC-gfxProgram:

• Running the EC-gfxProgram Application.

• Running EC-gfxProgram from your PC’s Desktop (or from Microsoft Win-
dows’ All Programs).

• Launching EC-gfxProgram through an EC-BOS or EC-Net Pro.

EC-gfxProgram can also be launched from a Px Page. See Launching EC-
gfxProgram from a Px Page using a LaunchButton Widget.

NOTE: A device’s EC-Net EC-gfxProgram application can only be used from 
one location at a time. For example, if one user at one PC has a par-
ticular EC-gfxProgram application open, another user at another PC 
cannot access that same EC-gfxProgram application.

Running the EC-gfxProgram Application

An EC-Net Wizard allows the user to program and/or configure an EC-gfxPro-
gram compatible device through the EC-Net platform. Those familiar with LNS 
networks would recognize these wizards as plug-ins. The look and functional-
ity of the wizards are just like LNS Plug-ins.
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1. Open EC-gfxProgram by right-clicking the device in the Nav Side Bar, and 
selecting Launch Wizard. The EC-gfxProgram splash screen appears.
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Running EC-gfxProgram from your PC’s Desktop

Run EC-gfxProgram from your PC’s desktop (or from Microsoft Windows’ All 
Programs) as follows.

1. Click / double click either EC-gfxProgram icon in the Start menu (left) or 
on the desktop (right). 

 

2. Enter the connection information to the building controller and click OK.

Parameter Description 

Server type To connect to a LONWORKS network through EC-Net, set the Server type to 
Lon AX.

Connection Mode Select Direct connection when the IP address of the EC-BOS or EC-Net Pro 
building controller is directly accessible from your PC (the address of which is 
set in Server address).

Server address The building controller’s (or Target Host’s) IP address. If the IP address is 
unknown for an EC-BOS, use the System Shell procedure documented under 
Recovery Tips in the EC-BOS Install and Startup Guide. This document can 
be downloaded from the Distech Controls website at www.distech-
controls.com.

Server port By default, this is 1931.

Username Enter your username for the EC-Net station's (or Target Host’s) Station.

Password Enter your password for the EC-Net station's (or Target Host’s) Station.
EC-gfxProgram 43

http://www.distech-controls.com
http://www.distech-controls.com


3. Click OK. The Select Devices window appears.

4. Select the device to open in EC-gfxProgram and click OK.

5. The device’s EC-gfxProgram code appears.

Launching EC-gfxProgram through an EC-BOS or 
EC-Net Pro

When logged in to an EC-BOS or EC-Net Pro station, launch EC-gfxProgram 
as follows.

1. Double-click BcpLonNetwork in the tree and then click Discover to find 
the available devices on the network.

2. The discovered devices for the network are listed.

3. Launch the EC-gfxProgram application by right-clicking the device and 
select Launch Wizard.
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4. The device’s EC-gfxProgram appears.

Launching the Scheduler Configuration Wizard 
(ECP Series)

For controllers that support schedules, launch the scheduler wizard as fol-
lows: 

1. Launch the Scheduler Configuration Wizard by right-clicking the device. 
Select Wizards and from the list select a Schedule. 
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2. To configure the Scheduler Configuration Wizard (for ECP Series control-
lers only), see Scheduler Configuration Tool in the EC-gfxProgram User 
Guide.

Launching the Real-Time Clock Configuration Wiz-
ard (ECP Sereis Controllers)

For controllers that have a real time clock, launch the RTC plug-in as follows: 

1. Launch the Real-Time Clock Configuration Wizard by right-clicking the 
device. Select Wizards and from the list select Rtc.
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2. To configure the RTC Configuration Wizard (for ECP Series controllers 
only), see Real Time Clock Configuration Tool in the EC-gfxProgram User 
Guide.
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Launching EC-gfxProgram from a Px Page using a 
LaunchButton Widget

By adding a LaunchButton widget to a Px Page, a user can launch any action 
found by right-clicking the device and selecting Wizards. This includes 
launching EC-gfxProgram. The Px page must be displayed through one of the 
WbWeb profiles to work. Add a LaunchButton to a Px Page as follows:

1. Expand the Widgets folder and drag and drop the LaunchButton widget 
from the distechControls palette onto the Px Page.

2. Double click the Launch button on the Px Page to open the Properties 
window. Configure the button’s look and behavior in the Image Button 
section.

3. Under the Bcp Command Binding, click ... in Ord.

4. Select the device for the LaunchButton wizard action: select Component 
Chooser from the Ord dropdown list. 
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5. In the Select Ord window, select the device for the LaunchButton wizard 
action under Drivers, BcpLonNetwork. Set the type to Slot. Click OK. 

6. Set the button behavior when the service is unavailable in degradeBe-
havior.

7. Set the Wizard to launch in the commandIndex. This number corre-
sponds to the list of wizards shown when you right-click the device 
selected above for the LaunchButton wizard action and select Wizards. 

For example, by right-clicking the device and selecting Wizards, the fol-
lowing options are shown (EC_gfxProgram, Rtc, Scheduler 1, and 
Scheduler 2). For the LaunchButton wizard to launch the first item 
(EC_gfxProgram (EC-gfxProgram), set the commandIndex to 0. To 
launch the second item (Rtc), set the commandIndex to 1. To launch the 
third item (Scheduler 1), set the commandIndex to 2. To launch the 
fourth item (Scheduler 2), set the commandIndex to 3.

8. Click Save.

9. Click  to toggle the view/edit mode to View. Click the LaunchButton 
widget to test its behavior.

If there is only a Launch Wizard and no Wizards selection, there is 
only one wizard available for this device. Set the commandIndex to 
0 to launch this wizard.
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CHAPTER 3
Getting Started on EC-Net for ECB and 
ECY Series Controllers

This chapter provides a detailed explanation of how to configure an EC-BOS 
as a building controller with EC-Net installed on your PC. This includes install-
ing EC-gfxProgram, adding a device to a network database, and launching 
EC-gfxProgram. 

Topics

Pre-Configuration Checklist and Configuration Overview
Installing EC-gfxProgram
Installing the Distech Controls Distribution File on the EC-BOS
Adding the Wizard Service to the Station
Configuring the WizardService
Installing a Bcp BACnet Network
Installing the BACnet Communication Port(s)
Tuning the Proxy Point Policies
Organizing Controllers in the Device Folder
Creating Station Users
Configure the REST and Radius Services (for ECY Series controllers)
Discovering BACnet Devices
Setting the Max Master and Max Info Frames on all MS/TP Devices (ECB Se-
ries)
Launching EC-gfxProgram
Launching EC-gfxProgram from a Px Page Using a LaunchButton Widget 
(ECB Series Controllers Only)
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Pre-Configuration Checklist and Configuration Over-
view

EC-gfxProgram requires that the EC-BOS, EC-Net Pro, and EC-Net be 
licensed for version 3.5 or higher. Furthermore, ECY Series controllers 
require that in Platform Administration, the Java Virtual Machine should be 
oracle-jre-qnx-ppc.

Pre-
Configuration 
Steps

Before installing EC-gfxProgram, adding a device to a network database, and 
launching EC-gfxProgram, the following steps must first be carried out to 
allow EC-Net to support the controllers:

1. Install EC-Net Pro on your computer.

2. Install the latest version of the Distech Controls EC-Net Support Package 
on your computer. The EC-Net Support Package installs many jar files 
required in EC-Net such as distechControls.jar, which contains the 
required services and Distech Controls devices. The latest Support Pack-
age can be installed by using the Distech Controls SmartInstaller soft-
ware. The Distech Controls SmartInstaller software can be downloaded 
from the Distech Controls website at www.distech-controls.com. 

If you are running EC-Net 4 and your Niagara license file has a brandID 
other than distech or distechEU, you will require a license to enable the 
WizardService, RestService, and RadiusService. See Licensing the EC-
Net Support Package for a Non-Distech Controls Brand Station.

3. Connect to an EC-BOS or EC-Net Pro station. If the IP address is 
unknown for an EC-BOS, use the System Shell procedure documented 
under Recovery Tips in the EC-BOS Install and Startup Guide. This docu-
ment can be downloaded from the Distech Controls website at www.dis-
tech-controls.com.

Configuration 
Steps

The following steps are detailed in procedures on the following pages.

1. Install EC-gfxProgram.

2. Install the Distech Controls EC-BOS distribution file through the platform 
Distribution File Installer.

3. Add the WizardService to the station.

4. Configure the WizardService.

5. Add a BcpBACnet Network to the station.

6. Add a BACnet MS/TP Communication Port, a BACnet IP Communication 
Port, or both to the BcpBacnet Network.

7. Tune the proxy point Policies.

8. To support ECY Series controllers, configure the REST and Radius ser-
vices.

9. Create device folders into which controllers will be organized.

10. Discover BACnet Devices.
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11. Set the Max Master and Max Info Frames on all MS/TP Devices.

12. Launch device wizards to run EC-gfxProgram.

NOTE: When first logging in to the platform, the default platform username is 
distech and the default password is controls.
EC-gfxProgram 53



Installing EC-gfxProgram

To program a controller, the EC-gfxProgram application must be installed. 
This application has its own setup file and requires its own installation. EC-
gfxProgram must be installed as follows:

1. Close any programs that are running on the PC. 

2. Go to the Software Center, which can be downloaded from the Distech 
Controls website at www.distech-controls.com.

3. In the EC-gfxProgram tab, select Distech Controls EC-gfxProgram.

4. Run the Setup file and follow the installation instructions.

NOTE: When installing EC-gfxProgram and your PC does not have the Bon-
jour service installed, a link to install the Bonjour service is provided. 
The Bonjour service must be installed on your PC to allow your PC to 
discover ECY Series controllers by their hostname. 
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Installing the Distech Controls Distribution File on 
the EC-BOS

Install the Distech Controls distribution file onto the EC-BOS to ensure all of 
the required modules and files are correctly installed.

1. Expand the platform tree in the Nav side bar and double-click Distribu-
tion File Installer. This will open the Distribution File Installer in the View 
Pane.

2. Click on Choose Directory at the bottom of the page and navigate to the 
location of the Support Package. These files are usually found in the
/Niagara/EC-NET[Version#]/Distech Controls Files/ directory on the C: 
drive. Click OK.
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3. Install the DistechControls_EC-BOS distribution file through the platform 
Distribution File Installer. Select the distribution file and click Install.

4. EC-Net will then inform you that any running station(s) must be closed in 
order to continue. Click Finish.

5. If any application needs to be stopped, allow the platform to stop them.
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6. The Installing Distribution window will appear to display the progress of 
the distribution files installation. Click Close when done and allow some 
time for the EC-BOS to reboot.
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Adding the Wizard Service to the Station

Install the WizardService on the station to allow EC-gfxProgram to connect to 
the EC-BOS.

1. Connect to the station on the EC-Net platform. Right-click the station and 
select Connect.

NOTE: If this is the first time that the station is accessed, by default, the sta-
tion will not be displayed. Click File > Open > Open Station (or by 
pressing Ctrl+Shift+O from your keyboard) to open the Open Station 
window. Proceed to step 2.

2. Enter the required Username and Password to access the station.

3. Click the Open Palette button in the Palette side bar to open the Open 
Palette selection window.

NOTE: If the Palette side bar is not open in the Side Bar Pane, click 
Windows > Side Bars > Palette to add the Palette side bar.

4. Select distechControls from the Open Palette selection window and 
click OK. This will add the distechControls palette to your Palette side 
bar.

5. Install the WizardService: Drag and drop the WizardService from the 
distechControls Palette into the Station’s Services tree.
58 EC-gfxProgram



Getting Started on EC-Net for ECB and ECY Series Controllers
NOTE: The Services tree is found within the Config tree of the station.

6. Click OK to add the WizardService on the station.
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Configuring the WizardService

The WizardService must be configured by defining parameters such as the 
communication port and/or the number of simultaneous connections. The 
WizardService property sheet can be accessed:

• From the Nav side bar, double-click WizardService in the Services tree 
of the station.

• From the Nav side bar, right-click WizardService, select Views > Prop-
erty Sheet.
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Parameter Description 

Status (read only) This field displays the status of the BCP Server. If the server is enabled 
(the Enabled field set to True), an {ok} status will be displayed. If the 
server is disabled (the Enabled field set to False), an {disabled} status 
will be displayed.

Fault Cause (read only) If there is a problem with the WizardService, this field will list the possible 
cause of the problem.

Enabled This field enables or disables the WizardService. Enable the server by 
setting this field to True. Likewise, the server can be disabled by setting 
this field to False.

Licensed This is true when the WizardService is licenced on this station and is 
available. When using Distech Controls controllers with a Distech 
Controls EC-Net station, these services are available by default. 

If you are running EC-Net 4 and your Niagara license file has a brandID 
other than distech or distechEU, you will require a license to enable the 
WizardService, RestService, and RadiusService. See Licensing the EC-
Net Support Package for a Non-Distech Controls Brand Station.

Port Set the port that the station is use to communicate with EC-Net. The 
default port is 1931.

Max Connections This is the maximum number of connections (wizards) that can be 
simultaneously running. The default is 5.

Version (read only) This field displays the current version of the Wizard Service 
communication protocol.

Min Version (read only) The minimum required version of the Wizard Service communication 
protocol that is required for this service to operate.

Number Connections 
(read only)

Number of clients (wizards) currently running and using the 
WizardService. See Server Connections.

Server Connections

- Keep Alive Delay

- Load Manager

- Connection

Sets the server connection parameters. See Server Connections. The 
number of supported connections is set in Max Connections.

Supported Field Bus List the network types supported by the WizardService.

Bacnet Settings

- Temporary APDU 
Timeout

BACnet transaction timeout used by the wizards.

Bacnet Settings

- Bcp Device Def

This defines the device manufacturer’s models which are recognized as 
a compatible BACnet device.
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Server Connections

The server connection parameters can be viewed as shown below.

Bacnet Settings

- Default Enable 
Writable Proxies

Enable writable proxies when created with point manager.

Bacnet Settings

- Force Proxy Read 
Status Flags

Read status flag for proxy points.

LonWorks Settings Not applicable to BACnet controllers.

Wizard Settings

- Default Numeric Point 
Precision

Numeric precision for floating point numbers displayed by the proxy 
points created with the Create Points device action.

Wizard Settings

- Create Proxy Point 
Description

Uses the EC-gfxProgram block property description to be created as a 
description property under proxy points created with the Create Points 
device action. This description can ultimately be used to provide 
descriptive information on a Px Graphic Page.

Installed Version The currently installed WizardService version. This version number 
corresponds to the currently installed support package version.

License Manager

- Wizard Service 
Licensed

- Radius Service 
Licensed

- Rest Service Licensed

Shows the license status for the Distech Controls Support Package 
services (WizardService, RestService, and RadiusService) on the 
current station. This is true when the service is licenced on this station 
and is available. When using Distech Controls controllers with a Distech 
Controls EC-Net station, these services are available by default. 

If you are running EC-Net 4 and your Niagara license file has a brandID 
other than distech or distechEU, you will require a license to enable the 
WizardService, RestService, and RadiusService. See Licensing the EC-
Net Support Package for a Non-Distech Controls Brand Station.

WizardService_LonLeg
acy

Not applicable to BACnet controllers.

RestService It may be necessary to configure these services to support advanced 
ECY Series controller features. See Configure the REST and Radius 
Services (for ECY Series controllers).RadiusService

Refresh Click to reset the fields to the last saved values of the WizardService.

Save Click to save any changes made to the fields of the WizardService.

Parameter Description 
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Parameter Description 

Server Connections

- Keep Alive Delay

Set the delay after which an idle connection is disconnected. This is 
calculated from the Last Transaction Time shown below in the 
connection.

Server Connections

- Load Manager

The load manager disrupts BACnet and LONWORKS EC-gfxProgram 
debugging sessions for heavily loaded stations in order to avoid watchdog 
resets.

Enable: Enable the load manager.

Detected Overload becomes true when the platform CPU (%) remains 
above the Full load Threashold for a duration at least equal to the Full 
load delay.

EC-gfxProgram debugging will be disrupted when the Detected Overload 
flag becomes true.

The flag is reset with the reset action available on the Load Manager: 
right-click Load Manager and select Reset.
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Server Connections

- Connection1

- Connection2

…

Inet Address: The Station name or IP address of the PC or Client 
Application making this connection. 

User Name: The user name from the Workbench or EC-gfxProgram used 
to connect to the EC-Net.

Application Name: The name of the connected application.

Authentication Type: How the application connected. Workbench or 
Digest (launch from desktop).

Protocol Version: The bcp protocol version.

Login Time: The time the connection was established.

Last Transaction Time: The time of the last transaction.

Parameter Description 
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Installing a Bcp BACnet Network

In the following procedure, you will add a Bcp BACnet Network; assign the 
network number and Device ID for the BACnet IP network. It is useful to have 
an organized numbering scheme that makes it easier to keep track of a 
device’s MAC Address, Instance Number, and Network Number that is 
assigned to it. See the Network Guide for an example of such a numbering 
Scheme.

NOTE: The Bcp BACnet Network provides extended functionality to the stan-
dard BACnet Network for enhanced support for Distech Controls con-
trollers in EC-Net. Third party BACnet devices can be added to the 
Bcp BACnet Network and used as they would in the standard BACnet 
Network.

1. Install the BACnet Network: Double-click Drivers in the Nav tree for your 
station and click New.

2. From the Type to Add drop-down list, select Bcp Bacnet Network. Add 
one (1) BACnet networks in Number to Add.

3. Accept the default settings: Click OK.
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4. Double-click Local Device found under the BACnet driver and set the 
Device ID (shown as Object ID). This must be a unique number for this 
device in the entire BACnet network internetwork. The valid range is 0 to 
4194302. Click Save.

5. If you have other devices to communicate with BACnet IP, for example, 
an ECY Series controller, expand Bacnet Comm in the Nav tree, and 
then double-click Network. Expand IP Port and set the Network Number 
(1 to 65534). Expand Link and set the Adapter and IP Device Type. 
Click Save.

For an EC-Net Pro, select the PC’s Ethernet card to be used for the BAC-
net network. For an EC-BOS, select the Onboard Ethernet Adaptor en0 
when using the LAN1 (pri) LAN connector for this BACnet network con-
nection and select the Onboard Ethernet Adaptor en1 when using the 
LAN2 (sec) LAN connector for this BACnet network connection.

The IP Device Type options are as follows:

• Standard: Select this when connected to a LAN; however an Internet 
WAN connection (through an IP router) is not required for BACnet 
intranetworking.

• Foreign Device: Not applicable.
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• Bbmd: Select this when connected to a LAN and an Internet WAN 
connection is required for BACnet intranetworking using BACnet/IP 
Broadcast Management Device protocol. This allows BACnet com-
munications to pass through standard IP routers, along with proper 
routing configuration.

The BACnet BBMD Address is the internet network address when 
BBMD is enabled for remote connectivity. The valid rage is 1 to 65534.

6. Enable the IP port: Expand Network and right-click IpPort, select 
Actions > Enable.
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Installing the BACnet Communication Port(s)

BACnet communication ports need to be added to the BcpBacnet Network 
according to the type of BACnet controller you will be connecting to:

• For ECB Series controllers, add a BACnet MS/TP Communication Port. 
See Installing the BACnet MS/TP Communication Port.

• For ECY Series controllers, Configure the IP communication network port 
on the EC-BOS and add a BACnet IP Communication Port. See Installing 
the BACnet IP Port.

If both ECB Series controllers and ECY Series controllers are going to be 
used, add a BACnet MS/TP Communication Port and a BACnet IP Communi-
cation Port to the BcpBacnet Network.

Installing the BACnet MS/TP Communication Port

In the following procedure, you will assign the network number and MAC 
Address to the BACnet MS/TP network. It is useful to have an organized num-
bering scheme that makes it easier to keep track of a device’s MAC Address, 
Instance Number, and Network Number that is assigned to it. See the Net-
work Guide for an example of such a numbering scheme.

To communicate with BACnet MS/TP devices, install the BACnet MS/TP 
driver.

1. Install the BACnet MS/TP port to the communication port of the BACnet 
Network: Expand NetworkPorts found under Drivers > Bacnet in the 
distechControls palette, and Drag and drop MstpPort from the Palette 
to the Network tree.
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2. Give the BACnet MS/TP port a name and click OK.
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3. Double-click the MstpPort in the tree and give this BACnet MS/TP net-
work its unique Network Number. 

4. Expand Link and set the Port Name to COM1 or COM2 as labelled on 
the EC-BOS’ nameplate), set the Baud Rate to Baud_38400 (recom-
mended), set the Mstp Address to 0 (this is the MAC Address of the EC-
BOS on the BACnet MS/TP network – it must be 0), set the Max Master, 
and click Save.

NOTE: When commissioning a BACnet MS/TP Data Bus, it is useful to start 
with the Max Master set to 127 so as to be able to discover all devices 
connected to the data bus. Then, once all devices have been discov-
ered and the MAC Addressing is finalized by eliminating any gaps in 
the address range, set the Max Master (maximum MAC Address) in 
the EC-BOS (Building Controller) to the highest Master device’s MAC 
Address number to optimize the efficiency of the data bus. See Set-
ting the Max Master and Max Info Frames on all MS/TP Devices (ECB 
Series).

5. Enable the BACnet MS/TP port: Right-click MstpPort and select 
Actions > Enable.
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Installing the BACnet IP Port

You must connect to the configuration Web interface of a new ECY Series 
controller to change its IP address according to your network planning docu-
mentation. See the ECLYPSE User Guide for more information.

In the following procedures, you will install the BACnet IP port and assign the 
network number to the BACnet IP network. It is useful to have an organized 
numbering scheme that makes it easier to keep track of a device’s MAC 
Address, Instance Number, and Network Number that is assigned to it. See 
the Network Guide for an example of such a numbering scheme. 

To communicate with BACnet IP devices, install the BACnet IP port.

1. Install the BACnet IP port into the BACnet communications network: 
Expand NetworkPorts found under Drivers > Bacnet in the distech-
Controls palette, and Drag and drop IpPort from the Palette to the Net-
work tree.
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2. Give the BACnet IP port a name and click OK.

3. Double-click the IpPort in the tree and give this BACnet IP network its 
unique Network Number. 
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4. Expand Link and set the Ethernet port to use in Adapter. If you connected 
the ECY Series controller(s) to the LAN2 Ethernet port, then select DM1.

5. Enable the BACnet IP port: Right-click IpPort and select Actions > 
Enable.
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Tuning the Proxy Point Policies

By using the Bcp Bacnet Network driver, an EC-BOS or EC-Net Pro has 
Tuning Policies set by default to not write values in the controllers when the 
EC-BOS or EC-Net Pro starts up or reboots due to its use of the BcpPolicy 
tuning policy. This is the behavior most often required by users. The BcpPol-
icy tuning policy is used as the default policy during proxy point generation.

NOTE: Under certain circumstances, it may be necessary to write values to 
the controllers when the EC-BOS or EC-Net Pro startup or reboot. For 
a complete description the station’s proxy point tuning policies for 
BACnet network devices, or to create exceptions for network variables 
that must be overwritten by the station, refer to the EC-Net Drivers 
Guide. See ‘About Tuning Policies’.
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Organizing Controllers in the Device Folder

Use a device folder to group similar devices together (for example, by floor). 
Create these folders first and then add the controllers directly into the appro-
priate folder.

1. Double-click the BcpBacnetNetwork driver in the Nav Side Bar. This will 
display the BACnet Network database in the View Pane. Click New 
Folder. 

2. Name the new folder and click OK.

3. Double-click the folder to go into it. 

4. When adding a controller, add it directly into the folder.
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Creating Station Users

User access rights ensure secure access to the BMS by authorized users 
only. In EC-Net users are managed under the UserService. The service pack 
adds the Radius User Config and Mobile Web Profile to each user’s profile.

An EC-Net station can be used as a RADIUS server for one or more ECY 
Series controllers. This centralizes user access management to all ECY 
Series controllers across the BMS. This is configured under a user’s profile in 
RadiusConfig.

Software applications are available that allow remote connection to connected 
controllers. This is configured under a user’s profile in Mobile Web Profile.

Add users to the station and configure their profile as follows.

1. Add all users to the station that will authenticate themselves when 
accessing an ECY Series controller. Double-click UserService under Sta-
tion > Config > Services and click New.

2. Create a user with a username and password. 

3. Click OK.

4. Double-click the new user.

5. Under Wizard Service Config, set Enable Write to false to prevent a 
user from writing to the controller from a mobile application. If this user is 
allowed to remotely change controller parameters, set Enable Write to 
true.

6. To enable this user to authenticate themselves when accessing an ECY 
Series controller, set their access rights in RadiusConfig options. Click 
Save.

Parameter Description 

Admin Allows user access to the ENVYSION studio and viewer. The user can also view 
and modify all configuration interface parameters and program the controller 
with EC-gfxProgram. 

Operator Allows user access to the ENVYSION interface in viewing mode as well as 
gives partial access to the ECLYPSE Web Configuration Interface. Certain 
configuration interface screens are unavailable such as User Management, 
Viewer Information, etc.

Viewer Allows user access to the ENVYSION interface in Viewing mode. The user is 
not allowed to access the ECLYPSE Web Configuration Interface.
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Rest Allows a user to program an ECY Series controller with EC-gfxProgram. 

To program one or more ECY Series controllers with EC-gfxProgram through 
this EC-Net station:

1. A ‘REST user’ must be created such that this REST user’s login and pass-
word can be authenticated on those ECLYPSE controllers. This REST user 
must have the REST user access rights option enabled. 

2. The RestService must be configured on the EC-Net station with this REST 
user’s login and password. 

See Configuring the REST Service for more information about this option.

This user does not have access to the ECLYPSE Web Configuration Interface 
or ENVYSION.

Parameter Description 
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Configure the REST and Radius Services (for ECY 
Series controllers)

From Service Pack V3.9, new REST and Radius services were added to the 
EC-Net Station under Station > Config > Services > WizardService. Both 
these services must be configured to support advanced ECY Series controller 
features.

Configuring the REST Service

The REST service allows EC-gfxProgram to pass-through an EC-Net station 
to communicate with ECY Series controllers. EC-gfxProgram connects to EC-
Net through the WebService and EC-Net connects to an ECY Series control-
ler through the RestService. 

For this, all ECY Series controllers operating under EC-Net need to be config-
ured in their ECLYPSE Web interface under Server Settings to use the corre-
sponding settings for HTTP / HTTPS parameters set in the procedure below.

The RestService uses a ‘REST user’ credential (username and password) to 
connect to an ECY Series controller. This credential is required in the proce-
dure below. As such, all ECY Series controllers must be configured in their 
ECLYPSE Web interface under User Management to be able to authenticate 
this REST user. If an ECY Series controller is using:

• This EC-Net station as its Remote Radius Server, then a new REST 
user profile needs to be created under Station > Config > Services > 
UserService of this station (see Adding a REST User to the UserSer-
vice). This REST service user profile must have Rest enabled under 
RadiusConfig. In the ECY Series controller’s Web Configuration Inter-
face User Management screen, set it to use this EC-Net station as its 
RADIUS server for remote authentication. The ECY Series controller then 
authenticates the REST user login using this EC-Net station’s Radius 
server. 

• A remote RADIUS server to authenticate user access (another ECY 
Series controller or Microsoft Windows Domain Active Directory server for 
example), then a new REST user profile needs to be created on that 
RADIUS server. In the ECY Series controller’s Web Configuration Inter-
face User Management screen, set it to use this remote RADIUS server 
for authentication. 

• Local user management, then a new REST user profile needs to be cre-
ated on each ECY Series controller that EC-Net will be connecting to. In 
the ECY Series controller’s Web Configuration Interface User Manage-
ment screen, add a REST user to the Local User Management.

The User Management screen of each ECY Series controller must be indi-
vidually configured.
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Use an uncommon username for this service for the REST user’s credential, 
such as Rest67service or RestServiceUser29, for example. Avoid the use of 
the default admin user, where this commonly-known username is one half of 
a username / password combination, the use of which would facilitate an 
attack. For both the WebService and RestService, it is strongly recommended 
to use HTTPS to encrypt communication channels to keep passwords secure 
by preventing eavesdropping. 

If the RestService credential cannot be authenticated, a user can still launch 
EC-gfxProgram, however the controller will be offline.

Adding a REST 
User to the 
UserService

If this EC-Net station is going to be used as the remote RADIUS server to one 
or more ECY Series controllers, then a new REST user profile needs to be 
added. 

1. Double-click UserService under Station > Config > Services. 

2. Click New.
EC-gfxProgram 79



3. Set 1 in Number to Add. Click OK.

4. Create a REST user with an uncommon username.

5. Create a strong password for the REST user profile.

6. Clear Force Password Reset.

7. Click OK.

8. Right-click the REST user profile and select View > Property Sheet.

9. Under Wizard Service Config, clear Enable Write.

10. Enable only the Rest option in RadiusConfig options. <
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Configuring the 
REST Service 
Connection

The RestService needs to be able to connect to an ECY Series controller as a 
user. To allow a secure connection between EC-gfxProgram and EC-Net, 
HTTPS needs to be enabled in the WebService. Configure these connections 
as follows.

1. Configure the RestService under Station > Config > Services > Wiz-
ardService. 

Parameter Description 

Status This field displays the status of the RestService Server. If the server is 
enabled (the Enabled field set to True), an {ok} status will be displayed. If the 
server is disabled (the Enabled field set to False), an {disabled} status will be 
displayed.

Fault Cause If there is a problem with the RestService, this field will list the possible cause 
of the problem.

Enabled This field enables or disables the RestService. Enable the RestService server 
by setting this field to True. Likewise, the server can be disabled by setting 
this field to False.

Licensed This is true when the RestService is licenced on this station and is available. 
For more information about support pack licensing, see Licensing the EC-Net 
Support Package for a Non-Distech Controls Brand Station.

Servlet Name The RestService servlet name.

Version This field displays the current version of the RestService communication 
protocol.
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2. Click OK. 

3. In the WebService, set Https Enabled to true. Click Save. If this is 
unavailable, ensure that the platCrypto service is installed in the Soft-
ware Manager.

User Name The username that REST service will use to logon to an ECY Series controller. 
The ECY Series controller must be able to authenticate this REST user either 
locally or through a remote RADIUS server. 

Password This is the REST user password.

Http Port The ECY Series controller device port number for the unencrypted REST 
service when Https Enabled is set to false. 

The same value must be copied to the Port Number parameter (under Use 
HTTP) in the Server Setting screen of the ECY Series Web configuration 
interface.

Https Port The ECY Series controller device port number for the encrypted REST service 
when Https Enabled is set to true. 

The same value must be copied to the Port Number parameter (under Use 
HTTPS) in the Server Setting screen of the ECY Series Web configuration 
interface.

Https Enabled Selects if communications with the REST service is to be encrypted or not. 
This changes which port number the service will be available on as set above.

If set to false, disable Use HTTPS and enable Use HTTP in the Server 
Setting screen of the ECY Series Web configuration interface.

If set to true, enable Use HTTPS and disable Use HTTP in the Server Setting 
screen of the ECY Series Web configuration interface. This is the preferred 
setting.

Socket Timeout Timeout while waiting for a response for a transaction with the ECY Series 
controller.

Connection 
Timeout

Timeout while establishing a REST connection with the ECY Series controller.

Nb Rest Devices This shows the number of ECY Series controllers connected to the REST 
service.

Nb Rest Devices 
Poll Ok

When you click Save to save changes to a parameter, Polling Devices 
becomes true; this shows the connection progress of ECY Series controllers 
connected to the REST service. The number of Nb Rest Devices Poll Ok 
should equal the number of Nb Rest Devices once Polling Devices returns 
to false.

Polling Devices When you change the User Name / Password, Polling Devices becomes 
true as it searches for ECY Series controllers to connect to the REST service.

Parameter Description 
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Configuring the Radius Service

A RADIUS server uses a challenge/response mechanism to authenticate a 
user’s logon credentials (username and password). When one or more ECY 
Series controllers subscribe to a RADIUS server, this RADIUS server pro-
vides centralized user management to control which users have access to 
any of these ECY Series controllers. 

The RadiusService on an EC-Net station is a RADIUS server that relies on 
user profiles created in the station’s UserService to authenticate a user’s 
logon credentials. From Service Pack V3.9, new options have been added to 
UserService to control user access rights to one or more ECY Series control-
lers. To add and configure EC-Net station users, see Creating Station Users. 

The RadiusService is compatible with ECY Series controllers only; authenti-
cation requests from other devices systematically receive an 'access denied' 
response. 

All ECY Series controllers that are going to use this EC-Net station as a 
RADIUS server need to be configured in their ECLYPSE Web interface under 
User Management to use this EC-Net station as their RADIUS server. Both 
the RadiusService and all subscribed ECY Series controllers use a common 
shared key that is used to encrypt and decrypt passwords to prevent eaves-
dropping. 

1. Configure the RadiusServer settings under Station > Config> 
Services > WizardService. 

Parameter Description 

Status This field displays the status of the RadiusService Server. If the server is 
enabled (the Enabled field set to True), an {ok} status will be displayed. If the 
server is disabled (the Enabled field set to False), an {disabled} status will be 
displayed.
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Fault Cause If there is a problem with the RadiusService, this field will list the possible 
cause of the problem.

Enabled This field enables or disables the RadiusService. Enable the RadiusService 
server by setting this field to True. Likewise, the server can be disabled by 
setting this field to False.

Licensed This is true when the RadiusService is licenced on this station and is 
available. For more information about support pack licensing, see Licensing 
the EC-Net Support Package for a Non-Distech Controls Brand Station.

Shared Key This is an encryption key that devices use to encrypt and decrypt user 
authentication credentials that are sent between devices. The shared key 
should be a long string of up 32 alphanumeric characters and symbols that 
would be difficult to guess. For example, he^sg3iq6pg2*gqw@89hsm,wz[

The same value must be copied to the Shared Key parameter in the User 
Management screen of the ECY Series Web configuration interface.

Auth Port The Radius server authentication request port number. The default is 1812.

The same value must be copied to the Authentication Port parameter in the 
User Management screen of the ECY Series Web configuration interface.

Acc Port The Radius server accounting request port number. The default is 1813.The 
same value must be copied to the Accounting Port parameter in the User 
Management screen of the ECY Series Web configuration interface.

Socket Timeout Leave this at its default value.

Duplicate Interval Leave this at its default value.

Max Failure The number of requests a client (an IP address) can make for authentication 
of credentials that fail after which the client is locked out from making any 
authentication of credential requests (the response is always fail) for a period 
set in Lockout Duration.

Lockout Duration Once a client has made too many failed authentication of credentials 
requests, this sets the time delay that must expire before the RADIUS server 
will once again try to authenticate a credential request from that client. 

NOTE: The objective of the Max Failure and Lockout Duration settings are 
to help prevent a dictionary attack on the RADIUS server to discover 
username / password combinations that can then be used to login to 
devices throughout the network.

Parameter Description 
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2. Click Save.

Only Database 
Devices

Set to true so that only ECY Series controllers currently listed in this EC-Net / 
EC-BOS database are allowed to use the RADIUS service. 

NOTE: This filters out authentication of credential requests from non-ECY 
Series controller IP addresses to help prevent an attack on the 
RADIUS server to discover username / password combinations that 
can then be used to login to devices throughout the network. 

For more information about the database, see Discovering BACnet Devices 
on page 102. 

Set to false when devices other than ECY Series controllers are using this 
RADIUS service. 

Parameter Description 
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Discovering BACnet Devices

Set each ECB Series controller’s MAC address before connecting it to the 
BACnet MS/TP network. To do so, refer to the controller’s hardware installa-
tion guide (this is usually done by setting DIP switches on the controller or 
through a communicating sensor).

Set each ECY Series controller’s IP address before connecting it to the BAC-
net IP network. To do so, refer to the ECLYPSE User Guide or to the control-
ler’s hardware installation guide.

Once the BACnet Network(s) have been established, devices can start to be 
added to the BACnet Networks that are running from the EC-BOS station. In 
the following procedure, you will discover the BACnet controllers and assign 
them their device IDs (instance number) that will identify the individual control-
lers across the BACnet intranetwork which is necessary when sharing net-
work points. 

It is useful to have an organized numbering scheme that makes it easier to 
keep track of a device’s MAC Address (ECB Series controllers), Instance 
Number, and Network Number that is assigned to it. See the Network Guide 
for an example of such a numbering scheme.

1. Double-click BcpBacnetNetwork in the tree and then click Discover to 
find the available BACnet devices on the network.

2. Select the network on which you want to discover devices. Select a net-
work you have enabled, for example, 364. Click OK.
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3. The discovered devices for the network are listed.
EC-gfxProgram 87



4. Add the device to this station. Select the device and click Add.

5. Set the Name for this device. 

6. For EC-gfxProgram compatible devices, set the Type to Bcp Bacnet 
Device. This is required to enable the EC-gfxProgram wizard. 

7. The MAC Address is automatically read from the controller.

8. Do not set the Device ID at this point. Click OK. The device is added to 
the Database.
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9. Select the device in the Database list and click DeviceID.

10. A Change Device ID popup appears. Click Yes.

11. Set the Device ID to device and set the Device ID according to your net-
work planning. This must be a unique number for this device in the entire 
BACnet network internetwork. The valid rage is 0 to 4194302. Optionally, 
set the Name for the device. Click OK. 

12. A Change Device ID popup appears. Click OK.

Once an ECY Series controller is discovered and added to the Station, 
find the Rest Status status in the controller’s Property Sheet. The status 
should be OK if the REST connection is working with the proper creden-
tials.
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13. Launch the EC-gfxProgram wizard by right-clicking the device and select 
Launch Wizard.
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Setting the Max Master and Max Info Frames on all 
MS/TP Devices (ECB Series)

This procedure is for ECB Series controllers and MS/TP devices connected to 
an MS/TP network only.

Once all devices have been discovered and the MAC Addressing is finalized 
by eliminating any gaps in the address range, set the Max Master (maximum 
MAC Address) in the EC-BOS (Building Controller) to the highest Master 
device’s MAC Address number to optimize the efficiency of the data bus as 
follows.

NOTE: Masters are devices that can initiate communications on the BACnet 
MS/TP bus. These devices can only have a MAC Address in the 0-
127 range.

The Max Master and Max Info Frames are parameters used to optimize a 
BACnet MS/TP Data Bus. This is set in the Bus Master (EC-Net Building Con-
troller) for the MS/TP port of the Bus Master and for each BACnet MS/TP 
device connected on that port.

A Configure MS/TP Devices tool is available to automate this task. This is 
only available in the WbWeb profile. This tool:

• Can only be used with a live database during commissioning. If you add 
more devices to the data bus, you must run this tool again. 

• Automatically calculates the value for the Max Master by finding the high-
est Master device MAC Address on the connected BACnet MS/TP data 
bus plus 1.

• Sets the Max Master for all master devices including the Bus Master (EC-
BOS).

• Sets the Max Info Frames for all master devices excluding the Bus Mas-
ter (EC-BOS).

In EC-Net, set the Max Info Frames to 20, as this is a device that will make 
more requests for service from other devices on the network. In general, 
according to the way a device is programmed, the Max Info Frames may 
have to be set to a higher value than for other devices. For example, when 
Roof Top Unit Controllers are used with VAV controllers that use gfxApplica-
tions code, they should also have their Max Info Frames set to a higher value 
such as 5, as Roof Top Unit Controllers poll VAV controllers for information.

Set the Max Master and Max Info Frames as follows. 
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1. Right-click the Link node in the Nav tree and select Ms/Tp Configura-
tion.

2. The network must be live; the Status shown in Configure Ms/Tp devices 
window must be {ok}.

3. A confirmation message is shown.
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4. Set the Max Info Frames to 20 for the Bus Master (EC-Net) as shown in 
the screen below.
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Launching EC-gfxProgram

EC-gfxProgram allows the user to program and/or configure an EC-gfxPro-
gram compatible device through the EC-Net platform.

Use any of the following methods to open EC-gfxProgram:

• Running the EC-gfxProgram application.

• Running EC-gfxProgram from your PC’s desktop (or from All Programs).

• Launching EC-gfxProgram through an EC-BOS or EC-Net Pro interface 
(ECB Series controller only).

NOTE: When connected to an ECY Series controller through EC-Net or EC-
BOS, when you save your EC-gfxProgram project, it is saved in both 
the EC-Net / EC-BOS station and in the controller itself. If you then 
directly connect to an ECY Series controller with EC-gfxProgram 
using the REST connection method, and save the EC-gfxProgram 
project to the controller, later when you again connect to the controller 
through the EC-Net / EC-BOS station, there will be a mismatch 
between the EC-gfxProgram project code versions. 
Whenever there is a mismatch between the EC-gfxProgram project 
code versions between the version in the controller and the version in 
the EC-Net / EC-BOS station, a pop-up window allows you to choose 
which project code version to use. A backup option copies both proj-
ect code versions to your PC’s hard disk.

Running the EC-gfxProgram Application

An EC-Net Wizard allows the user to program and/or configure an EC-gfxPro-
gram compatible device through the EC-Net platform.
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1. Open EC-gfxProgram by right-clicking the device in the Nav Side Bar, and 
selecting Launch Wizard. The EC-gfxProgram splash screen appears.

Running EC-gfxProgram from the Desktop

Run EC-gfxProgram from your PC’s desktop (or from Microsoft Windows’ All 
Programs).

1. Click / double click either EC-gfxProgram icon in the Start menu (left) or 
on the desktop (right). 

 

2. Enter the connection information to the building controller and click OK.
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3. Click OK. The Select Devices window appears.

4. Select the device to open in EC-gfxProgram and click OK.

Parameter Description 

Server type To connect to an ECB Series or ECY Series controller through EC-Net, set the 
Server type to BACnet AX.

Connection 
Mode

Select Direct connection when the IP address of the EC-BOS or EC-Net Pro 
building controller is directly accessible from your PC (the address of which is 
set in Server address).

Server address The building controller’s (or Target Host’s) IP address. If the IP address is 
unknown for an EC-BOS, use the System Shell procedure documented under 
Recovery Tips in the EC-BOS Install and Startup Guide. This document can be 
downloaded from the Distech Controls website at www.distech-controls.com.

Server port By default, this is 1931 for ECB Series controllers, 80 for an HTTP connection to 
ECY Series controllers, and, 443 for an HTTPS connection to ECY Series 
controllers.

Username Enter your username for the EC-Net station's (or Target Host’s) Station.

Password Enter your password for the EC-Net station's (or Target Host’s) Station.
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5. The device’s EC-gfxProgram code appears.

Launching EC-gfxProgram through an EC-BOS or 
EC-Net Pro (ECB Series Controllers Only)

When logged in to an EC-BOS or EC-Net Pro station, launch EC-gfxProgram 
as follows.

1. Discover the devices on the BACnet network. See Discovering BACnet 
Devices.

2. Launch the EC-gfxProgram application by right-clicking the device and 
select Launch Wizard.
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3. EC-gfxProgram opens for the device.
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Launching EC-gfxProgram from a Px Page Using a 
LaunchButton Widget (ECB Series Controllers Only)

By adding a LaunchButton widget to a Px Page, a user can launch any action 
found by right-clicking the device and selecting Wizards. This includes 
launching EC-gfxProgram. The Px page must be displayed through one of the 
WbWeb profiles to work. Add a LaunchButton to a Px Page as follows:

1. Expand the Widgets folder and drag and drop the LaunchButton widget 
from the distechControls palette onto the Px Page.

2. Double click the Launch button on the Px Page to open the Properties 
window. Configure the button’s look and behavior in the Image Button 
section.

3. Under the Bcp Command Binding, click ... in Ord.

4. Select the device for the LaunchButton wizard action: select Component 
Chooser from the Ord dropdown list. 

5. In the Select Ord window, select the device for the LaunchButton wizard 
action under Drivers, BcpBacnetNetwork. Set the type to Slot. Click 
OK.

6. Set the button behavior when the service is unavailable in 
degradeBehavior.
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7. Set the Wizard to launch in the commandIndex. This number corre-
sponds to the list of wizards shown when you right-click the device 
selected above for the LaunchButton wizard action and select Wizards. 

8. Click Save.

9. Click  to toggle the view/edit mode to View. Click the LaunchButton 
widget to test its behavior.

If there is only Launch Wizard and no Wizards selection, there is 
only one wizard available for this device. Set the commandIndex to 
0 to launch this wizard.
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CHAPTER 4
Licensing the EC-Net Support Package 
for a Non-Distech Controls Brand Sta-
tion

This chapter details how to license the Distech Controls Support Package for 
use on a non-Distech Controls brand station. Licensing for a non-Distech 
Controls brand station enables the following three support package services: 
WizardService, RestService, and RadiusService. For example, the Wizard-
Service is used to launch EC-gfxProgram as well as other wizards, create the 
proxy points, and allow the points to access the devices. Licensing is unnec-
essary when using Distech Controls controllers with Distech Controls EC-Net 
stations. 

Topics

Support Package Licensing Applicability
Support Package Services Overview
Getting a License
Installing the License
License Check
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Support Package Licensing Applicability

If you are running EC-Net 4 and your Niagara license file has a brandID other 
than distech or distechEU, you will require a license to enable the Wizard-
Service, RestService, and RadiusService. 

To verify your brandID, open the License Manager within the Platform. 

If you are using a Distech Controls EC-Net™ 4 Supervisor or an EC-BOS-8, 
the Niagara license brandID will be distech or distechEU. If this is the case, 
the three support package services will not require a license and will operate 
without any other intervention.
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Support Package Services Overview

Licensing applies to the following three support package services: WizardSer-
vice, RestService, and RadiusService. When the service is licensed, the sta-
tus is shown as true in the Licensed property of each service.

WizardService 
Overview

The WizardService is used to launch EC-gfxProgram as well as other wiz-
ards, create the proxy points and allow the points to access the devices.

RestService 
Overview

The RestService allows the RESTful API to run over HTTP requests and to 
run EC-gfxProgram for ECLYPSE™.
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RadiusService 
Overview

The RadiusService allows the RADIUS networking protocol to manage 
authentication requests from ECLYPSE devices.
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Getting a License

If you require a license, contact Distech Controls customer service to pur-
chase and license your support package. You will need to provide your Hos-
tID found in the WizardService, as shown below.

If your support package is unlicensed, the status of the services will be shown 
as false (as shown above). 

When ordering a license, the license must be chosen according to the avail-
able device packs. Once you have purchased a license, a zip file containing 
the license file will be sent to you by Distech Controls’ customer service. 

For more information regarding the available device packs, refer to the Dis-
tech Controls price list or SmartStore.
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Installing the License

There are two ways to install a license file; either with the WizardService 
through an Internet connection (online) or with the Import command through 
the WizardService License Manager (offline).

With an Internet 
Connection

1. Update the license through the WizardService: Right-click on WizardSer-
vice and select Actions > Update License. The licensing server is then 
contacted through the Internet and the license is automatically updated.

Without an 
Internet 
Connection

1. A zip file containing the license file will be sent to you by Distech Controls 
when an order is placed. To import the license file, right-click on the Wiz-
ardService License Manager property and select Import License.

2. Locate and select the license file you wish to import and click OK.

The licensing status is updated after importing the file.
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License Check

The licensing is automatically checked at station boot, every hour and every 
time a device or proxy point is added. There are no automatic licensing 
checks when devices or proxy points are removed.

You can also manually trigger a licensing check, with the “update license” 
action. You can also manually refresh after removing resources to update the 
device/proxy point count if needed. 

If the count limitations of the points or devices are exceeded, the three ser-
vices are disabled and a notification window is also displayed in EC-Net 4 
Pro. 
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	7. Set the Wizard to launch in the commandIndex. This number corresponds to the list of wizards shown when you right-click the device selected above for the LaunchButton wizard action and select Wizards.
	8. Click Save.
	9. Click to toggle the view/edit mode to View. Click the LaunchButton widget to test its behavior.
	Chapter 3
	Getting Started on EC-Net for ECB and ECY Series Controllers


	Pre-Configuration Checklist and Configuration Overview
	Pre- Configuration Steps
	1. Install EC-Net Pro on your computer.
	2. Install the latest version of the Distech Controls EC-Net Support Package on your computer. The EC-Net Support Package installs many jar files required in EC-Net such as distechControls.jar, which contains the required services and Distech Control...
	3. Connect to an EC-BOS or EC-Net Pro station. If the IP address is unknown for an EC-BOS, use the System Shell procedure documented under Recovery Tips in the EC-BOS Install and Startup Guide. This document can be downloaded from the Distech Control...

	Configuration Steps
	1. Install EC-gfxProgram.
	2. Install the Distech Controls EC-BOS distribution file through the platform Distribution File Installer.
	3. Add the WizardService to the station.
	4. Configure the WizardService.
	5. Add a BcpBACnet Network to the station.
	6. Add a BACnet MS/TP Communication Port, a BACnet IP Communication Port, or both to the BcpBacnet Network.
	7. Tune the proxy point Policies.
	8. To support ECY Series controllers, configure the REST and Radius services.
	9. Create device folders into which controllers will be organized.
	10. Discover BACnet Devices.
	11. Set the Max Master and Max Info Frames on all MS/TP Devices.
	12. Launch device wizards to run EC-gfxProgram.


	Installing EC-gfxProgram
	1. Close any programs that are running on the PC.
	2. Go to the Software Center, which can be downloaded from the Distech Controls website at www.distech-controls.com.
	3. In the EC-gfxProgram tab, select Distech Controls EC-gfxProgram.
	4. Run the Setup file and follow the installation instructions.

	Installing the Distech Controls Distribution File on the EC-BOS
	1. Expand the platform tree in the Nav side bar and double-click Distribution File Installer. This will open the Distribution File Installer in the View Pane.
	2. Click on Choose Directory at the bottom of the page and navigate to the location of the Support Package. These files are usually found in the /Niagara/EC-NET[Version#]/Distech Controls Files/ directory on the C: drive. Click OK.
	3. Install the DistechControls_EC-BOS distribution file through the platform Distribution File Installer. Select the distribution file and click Install.
	4. EC-Net will then inform you that any running station(s) must be closed in order to continue. Click Finish.
	5. If any application needs to be stopped, allow the platform to stop them.
	6. The Installing Distribution window will appear to display the progress of the distribution files installation. Click Close when done and allow some time for the EC-BOS to reboot.

	Adding the Wizard Service to the Station
	1. Connect to the station on the EC-Net platform. Right-click the station and select Connect.
	2. Enter the required Username and Password to access the station.
	3. Click the Open Palette button in the Palette side bar to open the Open Palette selection window.
	4. Select distechControls from the Open Palette selection window and click OK. This will add the distechControls palette to your Palette side bar.
	5. Install the WizardService: Drag and drop the WizardService from the distechControls Palette into the Station’s Services tree.
	6. Click OK to add the WizardService on the station.

	Configuring the WizardService
	Server Connections

	Installing a Bcp BACnet Network
	1. Install the BACnet Network: Double-click Drivers in the Nav tree for your station and click New.
	2. From the Type to Add drop-down list, select Bcp Bacnet Network. Add one (1) BACnet networks in Number to Add.
	3. Accept the default settings: Click OK.
	4. Double-click Local Device found under the BACnet driver and set the Device ID (shown as Object ID). This must be a unique number for this device in the entire BACnet network internetwork. The valid range is 0 to 4194302. Click Save.
	5. If you have other devices to communicate with BACnet IP, for example, an ECY Series controller, expand Bacnet Comm in the Nav tree, and then double-click Network. Expand IP Port and set the Network Number (1 to 65534). Expand Link and set the Adap...
	6. Enable the IP port: Expand Network and right-click IpPort, select Actions > Enable.

	Installing the BACnet Communication Port(s)
	Installing the BACnet MS/TP Communication Port
	1. Install the BACnet MS/TP port to the communication port of the BACnet Network: Expand NetworkPorts found under Drivers > Bacnet in the distechControls palette, and Drag and drop MstpPort from the Palette to the Network tree.
	2. Give the BACnet MS/TP port a name and click OK.
	3. Double-click the MstpPort in the tree and give this BACnet MS/TP network its unique Network Number.
	4. Expand Link and set the Port Name to COM1 or COM2 as labelled on the EC-BOS’ nameplate), set the Baud Rate to Baud_38400 (recommended), set the Mstp Address to 0 (this is the MAC Address of the EC- BOS on the BACnet MS/TP network – it must be ...
	5. Enable the BACnet MS/TP port: Right-click MstpPort and select Actions > Enable.

	Installing the BACnet IP Port
	1. Install the BACnet IP port into the BACnet communications network: Expand NetworkPorts found under Drivers > Bacnet in the distechControls palette, and Drag and drop IpPort from the Palette to the Network tree.
	2. Give the BACnet IP port a name and click OK.
	3. Double-click the IpPort in the tree and give this BACnet IP network its unique Network Number.
	4. Expand Link and set the Ethernet port to use in Adapter. If you connected the ECY Series controller(s) to the LAN2 Ethernet port, then select DM1.
	5. Enable the BACnet IP port: Right-click IpPort and select Actions > Enable.


	Tuning the Proxy Point Policies
	Organizing Controllers in the Device Folder
	1. Double-click the BcpBacnetNetwork driver in the Nav Side Bar. This will display the BACnet Network database in the View Pane. Click New Folder.
	2. Name the new folder and click OK.
	3. Double-click the folder to go into it.
	4. When adding a controller, add it directly into the folder.

	Creating Station Users
	1. Add all users to the station that will authenticate themselves when accessing an ECY Series controller. Double-click UserService under Station > Config > Services and click New.
	2. Create a user with a username and password.
	3. Click OK.
	4. Double-click the new user.
	5. Under Wizard Service Config, set Enable Write to false to prevent a user from writing to the controller from a mobile application. If this user is allowed to remotely change controller parameters, set Enable Write to true.
	6. To enable this user to authenticate themselves when accessing an ECY Series controller, set their access rights in RadiusConfig options. Click Save.
	1. A ‘REST user’ must be created such that this REST user’s login and password can be authenticated on those ECLYPSE controllers. This REST user must have the REST user access rights option enabled.
	2. The RestService must be configured on the EC-Net station with this REST user’s login and password.

	Configure the REST and Radius Services (for ECY Series controllers)
	Configuring the REST Service
	Adding a REST User to the UserService
	1. Double-click UserService under Station > Config > Services.
	2. Click New.
	3. Set 1 in Number to Add. Click OK.
	4. Create a REST user with an uncommon username.
	5. Create a strong password for the REST user profile.
	6. Clear Force Password Reset.
	7. Click OK.
	8. Right-click the REST user profile and select View > Property Sheet.
	9. Under Wizard Service Config, clear Enable Write.
	10. Enable only the Rest option in RadiusConfig options. <

	Configuring the REST Service Connection
	1. Configure the RestService under Station > Config > Services > WizardService.
	2. Click OK.
	3. In the WebService, set Https Enabled to true. Click Save. If this is unavailable, ensure that the platCrypto service is installed in the Software Manager.
	Configuring the Radius Service
	1. Configure the RadiusServer settings under Station > Config> Services > WizardService.
	2. Click Save.



	Discovering BACnet Devices
	1. Double-click BcpBacnetNetwork in the tree and then click Discover to find the available BACnet devices on the network.
	2. Select the network on which you want to discover devices. Select a network you have enabled, for example, 364. Click OK.
	3. The discovered devices for the network are listed.
	4. Add the device to this station. Select the device and click Add.
	5. Set the Name for this device.
	6. For EC-gfxProgram compatible devices, set the Type to Bcp Bacnet Device. This is required to enable the EC-gfxProgram wizard.
	7. The MAC Address is automatically read from the controller.
	8. Do not set the Device ID at this point. Click OK. The device is added to the Database.
	9. Select the device in the Database list and click DeviceID.
	10. A Change Device ID popup appears. Click Yes.
	11. Set the Device ID to device and set the Device ID according to your network planning. This must be a unique number for this device in the entire BACnet network internetwork. The valid rage is 0 to 4194302. Optionally, set the Name for the device....
	12. A Change Device ID popup appears. Click OK.
	13. Launch the EC-gfxProgram wizard by right-clicking the device and select Launch Wizard.

	Setting the Max Master and Max Info Frames on all MS/TP Devices (ECB Series)
	1. Right-click the Link node in the Nav tree and select Ms/Tp Configuration.
	2. The network must be live; the Status shown in Configure Ms/Tp devices window must be {ok}.
	3. A confirmation message is shown.
	4. Set the Max Info Frames to 20 for the Bus Master (EC-Net) as shown in the screen below.

	Launching EC-gfxProgram
	Running the EC-gfxProgram Application
	1. Open EC-gfxProgram by right-clicking the device in the Nav Side Bar, and selecting Launch Wizard. The EC-gfxProgram splash screen appears.

	Running EC-gfxProgram from the Desktop
	1. Click / double click either EC-gfxProgram icon in the Start menu (left) or on the desktop (right).
	2. Enter the connection information to the building controller and click OK.
	3. Click OK. The Select Devices window appears.
	4. Select the device to open in EC-gfxProgram and click OK.
	5. The device’s EC-gfxProgram code appears.

	Launching EC-gfxProgram through an EC-BOS or EC-Net Pro (ECB Series Controllers Only)
	1. Discover the devices on the BACnet network. See Discovering BACnet Devices.
	2. Launch the EC-gfxProgram application by right-clicking the device and select Launch Wizard.
	3. EC-gfxProgram opens for the device.


	Launching EC-gfxProgram from a Px Page Using a LaunchButton Widget (ECB Series Controllers Only)
	1. Expand the Widgets folder and drag and drop the LaunchButton widget from the distechControls palette onto the Px Page.
	2. Double click the Launch button on the Px Page to open the Properties window. Configure the button’s look and behavior in the Image Button section.
	3. Under the Bcp Command Binding, click ... in Ord.
	4. Select the device for the LaunchButton wizard action: select Component Chooser from the Ord dropdown list.
	5. In the Select Ord window, select the device for the LaunchButton wizard action under Drivers, BcpBacnetNetwork. Set the type to Slot. Click OK.
	6. Set the button behavior when the service is unavailable in degradeBehavior.
	7. Set the Wizard to launch in the commandIndex. This number corresponds to the list of wizards shown when you right-click the device selected above for the LaunchButton wizard action and select Wizards.
	8. Click Save.
	9. Click to toggle the view/edit mode to View. Click the LaunchButton widget to test its behavior.
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	Support Package Licensing Applicability
	Support Package Services Overview
	WizardService Overview
	RestService Overview
	RadiusService Overview

	Getting a License
	Installing the License
	With an Internet Connection
	1. Update the license through the WizardService: Right-click on WizardService and select Actions > Update License. The licensing server is then contacted through the Internet and the license is automatically updated.

	Without an Internet Connection
	1. A zip file containing the license file will be sent to you by Distech Controls when an order is placed. To import the license file, right-click on the WizardService License Manager property and select Import License.
	2. Locate and select the license file you wish to import and click OK.


	License Check

